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Willkommen

Die zweite Auflage dieses Buches ist nach dem Erfolg der ersten Auflage
komplett überarbeitet, ergänzt und verbessert; es basiert auf Reason 3. Die
erste Auflage, bezogen auf Reason 2.5, finden Sie als ›Musikproduktion
Reason v2.5.pdf‹ auf der Buch-CD.

Reason ist ein Musikprogramm, das Ansprüche der ganz unterschiedli-
cher Musiker zu erfüllen vermag. Für Anfänger ist Reason der ideale Start.
Das Programm bietet eine fast komplette Studioausstattung inklusive
Sounds und erfüllt außerdem didaktische Zwecke, da die Bedienung der
klassischen Studiotechnik nachempfunden ist.

Für Fortgeschrittene ist Reason eine leistungsfähige Komplettlösung mit
professionellen Optionen – oder ein modularer externer Klangerzeuger
mit 64 MIDI-Eingängen und endlos vielen Effekten.

Für Profis ist Reason ein gern benutztes Schweizer Messer bei der Reali-
sierung von Ideen und das optimale Programm für den Laptop. Es be-
herrscht viele Sample-Formate, spricht bis zu 64 Audio-Outs an, kommu-
niziert mit Pro Tools, Cubase, Nuendo, Logic und anderen Programmen –
sodass jede Reason-Vorproduktion problemlos ins große Studio verlegt
werden kann.

Reason ist extrem gut geeignet, Tricks der Musikproduktion nachvollzieh-
bar zu erklären. Es gibt keine interne Erweiterbarkeit, sodass jeder Re-
ason-Song auf jedem System läuft. Daher können Sie jedes Detail dieses
Buches durch Öffnen einer Beispieldatei genau nachvollziehen: Das Er-
gebnis klingt bei Ihnen wie bei mir. Und daher ist auch der Austausch von
Song-Dateien zwischen Musikern einfacher als anderswo. Als ich angefan-
gen habe, elektronische Musik zu machen, habe ich mir kaum etwas sehn-
licher gewünscht als ein solches Programm. 

Ist Reason einmal installiert, können Sie sich auf das Inhaltliche konzent-
rieren, müssen nicht ständig konfigurieren und haben damit mehr Zeit
für die Musik. Reason 3 arbeitet sowohl unter Windows 2000 und XP als
auch unter Mac OS X (die Version 2.5 unterstützte noch Windows 98 und
Mac OS 9).
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Reason ist eine Art Volkswagen unter den Musikprogrammen, ein Aus-
druck von ›positivem Kommunismus‹ in der Studiowelt. Es läuft stabil,
verbraucht wenig Computerleistung und bringt damit eine Komponente
in die computergestützte Musikproduktion ein, die vielfach verloren ge-
gangen ist oder sogar nie vorhanden war: Vertrauen – auch wenn Version
3.0 zunächst nicht ganz so fehlerfrei war wie 2.5. Allerdings: Meine eige-
nen Produktionen kommen bislang weder ausschließlich noch hauptsäch-
lich aus Reason. Zwar ist Reason in mein Studio integriert – in dem sich
einige Geräte angesammelt haben, die ich nicht missen möchte – und
wird für tighte Drums, Sequenzen, Ideenskizzen und Sounds benutzt
oder via ReWire als Klangerzeuger eingebunden. Die allgemeine Hard-
ware-Verkaufshysterie hat mich aber trotzdem noch nicht angesteckt.

Ich hoffe, ich kann mit diesem Buch dazu beitragen, dass Sie Ihre Ideen
für eigene Musik mit Reason realisieren oder – falls Sie schon mit Reason
arbeiten – besser umsetzen können. Falls Sie zu den ›klassischen‹ Musi-
kern gehören, die immer noch Hemmungen vor Musik-Software haben,
kann dieses Buch hoffentlich wenigstens ein wenig dabei helfen, dass Sie
Ihre Scheu vor dem Musikmachen mit dem Computer ablegen.

Heiner Kruse

Köln, im März 2006
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Drums

     
Drums

Drums spielen in der heutigen Musik eine besonders wichtige Rolle:
Drumgrooves und ihr Tempo sind prägende Stilelemente, durch die viele
Spielarten zeitgenössischer Musik kategorisiert werden. Wenn Sie Drum
& Bass oder R ’n’ B oder Electro machen wollen und möchten, dass Ihre
Musik auch so eingeordnet wird, dann sollten besonders die Drums nach
dem jeweiligen Stil klingen. Das soll keine Aufforderung zum Kopieren
oder zur Aufgabe Ihrer musikalischen Persönlichkeit zugunsten des Ein-
tauchens in eine Kategorie sein, sondern eher eine Hilfe für Einsteiger,
um Selbstvertrauen zu gewinnen und die Methoden kennen zu lernen. 

Da viele Hinweise genreübergreifend sind, sind sie letztlich über das
ganze Kapitel verteilt. Spätere Beispiele zeigen dann auch mehrere Instru-
mente im Zusammenspiel. 

Breakbeats und ihre Anfänge

Dass komplexe Breakbeats Schlag für Schlag selbst programmiert werden,
ist eher die Ausnahme. Der Umgang mit Loops ist in Deutschland gleich-
wohl nicht besonders hoch angesehen (›keine Eigenleistung‹), was unlo-
gisch ist, wenn man bedenkt, wie viele Künstler gerade hierzulande für
ihre Loop-basierte Musik gefeiert werden. Aber trotzdem: Wenn Ihre Mu-
sik vor allem Ausdruck Ihrer Selbst sein soll, sollten Sie vielleicht auch bei
den Drums so konsequent sein und nicht jemand anderen loopweise für
sich trommeln lassen.

Groove-Loops sind trotzdem oft ein guter Einstieg in eine Produktion und
auch ein Qualitätsmaßstab für das eigene Drum-Programming. Im Fol-
genden werden wir Beatkonstruktionen mit und ohne Verwendung von
Loop-Material kennen lernen. In der Praxis sind natürlich auch Mischfor-
men aus beidem mit verschiedensten Gewichtungen üblich.

Bevor wir uns an die Arbeit machen, noch ein wenig ›historischer‹ Hinter-
grund, der Ihnen vielleicht hilft, das Thema Breakbeats ein wenig besser
zu verstehen.
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Vereinfacht gesagt hat die Entwicklung von Breakbeats viel damit zu tun,
dass Menschen mit einer großen Plattensammlung begonnen haben, mit
Samplern herumzuspielen. Im Sampler wurden die alten Lieblings-
grooves zu neuem Leben erweckt und verfremdet. Aus vielen Produktio-
nen kann man die achtfach ineinander verschachtelten Loops oder die Ti-
mestretch-Klänge der Akai-S1000-Generation heraushören. So haben Hel-
den wie Doc Scott, Roni Size, Ray Keith, Ed Rush und Shy FX damals an-
gefangen.

Dabei lagen oft längere Schnipsel eines Grooves auf der Tastatur und nicht
jeder Schlag einzeln, wie das nach einer Bearbeitung durch ›ReCycle‹ und
anschließendes Laden in einen Dr. Rex der Fall ist. Diese Schnipsel wur-
den dann so gepitcht, dass sie im gewünschten Tempo spielten. Vor allem
bei ›Jungle‹ bedeutete das in der Regel: hochpitchen und schneller spie-
len.

Diese Arbeitsweise können Sie mit Reason (und ReCycle) wie folgt nach-
vollziehen. Verfolgen Sie dieses Beispiel bitte auch, wenn Sie kein ReCycle
besitzen – ich habe alles passend für Sie vorbereitet.

1 Öffnen Sie ›drumlooptry1.rns‹.

2 Exportieren Sie den geladenen Groove (›Drb20_fabio‹) als Audio-Datei.
Dazu wählen Sie File > Export Loop as Audio File.

Die dadurch erzeugte Audio-Datei finden Sie unter der Bezeichnung
›drumlooptry1.wav‹ auch im Ordner ›Audiodokumente‹ auf der Buch-CD.

3 Editieren Sie den Groove in ReCycle so, dass Sie mehrere interessante
Schnipsel haben, die bei unterschiedlichen Schlägen beginnen, dann
aber noch ein Weilchen weiterspielen.

4 Speichern Sie Ihre Bearbeitung als Rex-Datei (›rx2‹).

Eine auf diese Art erzeugte Rex-Datei finden Sie unter der Bezeichnung
›drumlooptry1.rx2‹ auch auf der Buch-CD.

5 Erzeugen Sie einen neuen Dr. Rex, und laden Sie dort das erzeugte
Rex-File. Alternativ öffnen Sie den Beispielsong ›drumlooptry2.rns‹.

Nehmen Sie auf der Dr. Rex 2-Spur einige Noten auf, oder laden Sie
›drumlooptry3.rns‹, wo ich das bereits für Sie erledigt habe.
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Das klingt nach ›gebrochenem‹ Beat, oder? Sie könnten ein vergleichbares
Ergebnis natürlich auch erreichen, wenn Sie einfach die verschiedenen
Schläge des Dr. Rex 1 editieren und verschieben. Das ist beispielsweise
eine geeignete Methode für die Variation der letzten Schläge kurz vor der
nächsten Eins, also zur Erzeugung eines kleinen ›Drum-Fills‹.

Auf die hier demonstrierte Art und Weise – mit den längeren Schnipseln –
können Sie mehr von Ihrem eigenen musikalischen Spielgefühl einbrin-
gen. Sie laufen so aber auch Gefahr, mit zusätzlichen Ungenauigkeiten
kämpfen zu müssen, wenn mehrere Loops übereinander laufen und un-
terschiedlich ›grooven‹ bzw. nicht quantisiert sind. Außerdem: Wenn nur
eines Ihrer Groove-Schnipsel ungenau geschnitten ist, spielt ja der ganze
Groove für eine Zeit leicht ›falsch‹.

Es ist auch sinnvoll und macht dazu noch Spaß, die Schnipsel im Editor
hin und her zu schieben, statt sie selbst via Tastatur zu spielen.

Öffnen Sie ›drumlooptry4.rns‹. Dort ist eine eintaktige Loop eingestellt.
So können Sie schnell Takt für Takt editieren. Für den jeweils nächsten
Takt klicken Sie einfach bei eingeschalteter Loop-Funktion mit den Pfeil-
tasten unten rechts zunächst unten (rechter Locator), dann oben (linker
Locator) einen Takt weiter.

Breakbeats layern mit Dr. Rex, NN-XT und Effekten

Wenn man viele Grooves übereinander legt, werden Abmischung und
Quantisierung zunehmend wichtig. Oft klingt es zu ruckelig, wenn viele
Loops nicht quantisiert wurden. In Reason können Sie grundsätzlich bes-
ser Drum-Loops übereinander legen als in irgendeinem anderen Pro-
gramm. Die Vorhörfunktion des Dr. Rex macht das besonders einfach, wie
Sie bereits in Kapitel 2 gesehen haben. Es gibt aber vor allen Dingen keine
Delays durch MIDI-Timing-Probleme, sodass Ihr Drum-Programming
›tight‹ werden kann. Das ist ein Grund, warum Reason auch in Profi-Stu-
dios oft als ›Beat-Erzeuger‹ dient, dessen Ergebnis dann als Audiodatei in
einen anderen Sequencer importiert wird.
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Das Übereinanderschichten vieler alter Loops macht die entstehenden
Grooves einerseits komplex und undurchschaubar. Andererseits hat diese
Arbeitsweise sicher nicht wenig dazu beigetragen, dass Drum & Bass ›ge-
rader‹ geworden ist. Denn es ist mit einem ›geraden‹ Beat einfacher, viele
Loops zu kombinieren. Frühe Protagonisten waren hier meiner Meinung
nach Alex Reece mit seinem ›Pulp Fiction‹ sowie die vielen V-Recordings-
Veröffentlichungen, mittlerweile macht es so ziemlich jeder.

Charakteristisch für die geraderen Drum-&-Bass-Beats ist die Betonung
des Snare-Schlages auf den Taktzählzeiten 2⁄4 und 4⁄4 (3⁄8 und 7⁄8 mit einer
Bassdrum auf 1⁄8 und 6⁄8), oder bei etwas krummeren Varianten auf 2 so-
wie ›3 und‹ (3⁄8 und 6⁄8 mit einer Bassdrum auf 1⁄8 und 4⁄8). 

Bevor man sich mit einem Klotz verschiedener Loops abschleppt, bei denen man selbst
irgendwann kaum noch durchblickt, hilft manchmal ›Resampling‹. Damit wird aus
vielen Loops wieder eine einzige, die dann bearbeitet werden kann. Allerdings ist es
dabei nicht mehr möglich, etwa eine Hi-Hat zwischendurch mal auszuschalten – es sei
denn, man sampelt mehrere Versionen.

Geradere Breakbeats verlangen nach einer anderen Art der Abmischung
und transportieren letztlich auch eine andere Art von Energie. Bassdrum
und Snare sollen in der Regel ›knallen‹. Bei Verwendung von Loops aus äl-
teren Produktionen ist dazu in der Regel eine Bearbeitung mit Klangver-
änderungs-Werkzeugen nötig. Wenn also etwa die Engländer vom wichti-
gen EQing bei den Drums sprechen, so sind damit vor allem diese ›alten‹
Drum-Loops gemeint. Denn die Drums sollen ja in der Regel nicht nostal-
gisch und altbacken klingen, sondern der modernen Soundästhetik ent-
sprechen.

Optimale Werkzeuge sind hier Hardware-Geräte mit Tiefpass- und Hoch-
pass-Filter sowie vier vollparametrischen EQs, wie beispielsweise einige
Modelle von TL-Audio, die hierfür oft verwendet werden.

Das Hochpass-Filter hat dabei häufig die Aufgabe, das leichte, kaum hör-
bare ›Rumpeln‹ zu beseitigen, das durch das Sampeln von Platte entstan-
den ist. Die weiteren Frequenzbänder werden dazu benutzt, einzelne
Schläge aus der Loop stärker oder schwächer zu betonen.
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Reason ist durch all seine Effekte und ihre unendliche Kombinierbarkeit
auch im Profi-Studio für die Erstellung von Drums eines der besten ver-
fügbaren Tools. Die neuen MClass-Tools helfen natürlich sehr, aber auch
mit den alten Equalizern lassen sich Erfolge erzielen.

Öffnen Sie ›loopeq1.rns‹. Hier habe ich versucht, die Loop mit den kleinen
PEQ-Equalizern klanglich zu verbessern. In der Spur ›Dr. Rex 2‹ spielt die
Original-Loop, in Spur ›Dr. Rex 1‹ die mit EQ bearbeitete Loop. Beide Pe-
gel sind so eingestellt, dass sie ungefähr gleich weit ausschlagen. Dann ist
der Vergleich gerechter – schließlich klingt ›lauter‹ bekanntlich immer
subjektiv ›besser‹. 

Auch habe ich versucht, ganz unten Bässe herauszunehmen, da ich die
Bassdrum des Originals ziemlich ›dröhnend‹ finde. Beim Anheben gehe
ich meist so vor, dass ich breitbandig anhebe, um einen bestimmten Be-
reich eher ›unauffällig‹ zu betonen. Beim Absenken geht es mir dagegen
eher darum, etwas Unangenehmes zu entfernen, und da versuche ich die
genaue Frequenz des betreffenden Sounds zu treffen und diese eher
schmalbandig abzusenken – Ausnahmen bestätigen die Regel.

Bei den meisten Equalizern klingt ein schmalbandiges Anheben künstlich
und relativ unangenehm, eine Ausnahme bilden da nur die ganz extrem
teuren Geräte. Daher gilt: Höchstens vorsichtig mit dem EQ nach Verbes-
serungen suchen, wenn man das Gefühl hat, dass eine Korrektur nötig ist.
Nicht aus purer Lust am EQ spielen, es sei denn, man will einfach ›experi-
mentieren‹. Zuviel EQing richtet oft mehr Schaden an, als es gut tut. Au-
gen- und Ohrenmaß sind gefragt.

So habe ich die Bassdrum an zwei Stellen schmalbandig abgesenkt und
einmal dazwischen wieder etwas breitbandiger angehoben. Anschließend
habe ich die Höhen breitbandig angehoben, was zugleich die Snare lauter
und präsenter macht. Ein zusätzliches Anheben der Snare-Frequenz emp-
fand ich zumindest auf meinen Boxen als zu extrem.

Eine alternative Strategie ist, einen Groove mit zusätzlichen Schlägen zu
unterlegen. Dann jedoch sollte man in den meisten Fällen davon Abstand
nehmen, im Ursprungs-Groove dieselben Schläge mit dem EQ zu beto-
nen – auch hier bestätigen Ausnahmen wieder die Regel: Wenn’s gut
klingt, ist alles erlaubt!
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Gerade wenn viele Loops und zusätzlich tiefe Bässe spielen, kann es wich-
tig sein, aus den Drums die Bassfrequenzen herauszufiltern. Reason be-
sitzt ja auch Hochpass- und Bandpass-Filter in den Instrumenten. Wenn
mehrere Dr. Rex zusammenspielen, sind die Filtertypen zwangsläufig ir-
gendwo aktiviert, wie Sie in den folgenden Beispielen sehen werden.

Öffnen Sie die Beispieldatei ›drummix.rns‹. Ab Takt 17 verstärkt Redrum
die Beats mit einer Bassdrum, einer Snare und Hi-Hats, also ganz unten,
in der Mitte und am oberen Rand des Frequenzspektrums. Die Bassdrum
der ›Bustabeat‹-Loop wurde dafür etwas abgesenkt.

Zudem sollten Sie Tools wie den Kompressor wenn überhaupt, dann nur
sehr vorsichtig auf die Summe aller Sounds legen. Öffnen Sie
›firststeps15.rns‹. Das gesamte Signal läuft hier durch den Scream 4, wo
›Tape‹-Kompressor eingestellt ist. Obwohl bei Takt 5 und 9 zusätzliche
Sounds spielen, wird der Gesamteindruck des Stücks eher leiser.

In ›firststeps16.rns‹ laufen nur die Drums durch den einfachen Kompres-
sor, nicht aber der Bass. Zudem ist ab ca. Takt 9 der Equalizer des im Vo-
coder eingebauten EQs aktiv, der hier Bässe wegfiltert. Zumindest auf
halbwegs Bass-starken Boxen fällt ab Takt 9 auf, dass Sie die Bassline we-
sentlich deutlicher ›heraushören‹ können.

In ›140bpmnur3.rns‹ spielen ebenfalls mehrere Loops, diesmal aber in
langsamerem Tempo. Meine Lieblingssounds sind Bässe, zu denen wir
später kommen, und drei meiner Bässe haben die Propellerheads in die
Factory Soundbank übernommen. Einen davon hören Sie hier aus einem
Combinator spielen, der allerdings nur auf einem bereits existenten
Sound basiert. Die Drums haben einen eigenen (Line-) Submixer, Equali-
zer und MClass-Kompressor. Eine Redrum spielt lediglich Bassdrum und
Snare ergänzend zu den Loops. Die Drums werden gemeinsam kompri-
miert, und es wird etwas Bass herausgefiltert.

Es ist schwer bis unmöglich, Ihnen hier die ganze Palette an Möglichkei-
ten aufzuzeigen. Sie müssen Fingerspitzengefühl bei der Kombination
der Tools beweisen.
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Noch zwei Beispiele: In ›175bpm01.rns‹ macht ein Scream 4 die Drums
›schmutziger‹, Redrum verstärkt die Bassdrum, Filter modulieren ergän-
zend. In ›175bpm01br3.rns‹ werden die Drums insgesamt in einem Sub-
mixer zusammengeführt und dann anschließend durch einen MClass
Compressor geleitet. Dieser wiederum ist so eingestellt, dass er recht kräf-
tig komprimiert. Ihre zusammengemixten Drums wirken nun kompakter
und mehr miteinander verschmolzen.

Sehr nützlich kann es auch sein, die einzelnen Sounds von Redrum mit
unterschiedlichen Effekten zu belegen. Redrum hat für alle Kanäle Einzel-
ausgänge. Und praktischerweise verschwindet jeder Sound, dessen Ein-
zelausgang verkabelt wurde, aus dem ›Stereo-Ausgang‹.

Drum-Rolls mit Matrix erzeugen

Im Beispielsong ›3drmsndsmatrixd.rns‹ bauen Sie aus drei Drumsounds
mit Effekten und Matrix-Sequencer auch ohne Groove-Loops lebendige
Breakbeats.

abb30013matrix1

Die Abbildung zeigt die drei Matrix-Sequencer aus dem Beispielsong
›3drmsndsmatrixd.rns‹.
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Jeder der drei Matrix-Sequencer ist via CV/Gate-Anschluss mit Redrum
verknüpft, steuert einen der drei Sounds aus Redrum an und ist entspre-
chend benannt. Der Matrix-Gate/CV-Out geht jeweils in den Gate/CV des
Redrum-Kanals und erzeugt die Noten-an/aus-Informationen gemeinsam
mit den zugehörigen Lautstärkeinformationen.

Wenn Sie im unteren Teil der Matrix-Sequencer neue Balken einzeichnen,
erzeugen Sie neue Schläge. Zu diesem Zweck sollten Sie nicht den Se-
quencer, sondern nur Matrix mit der ›Run‹-Taste laufen lassen. Dann hö-
ren Sie auch nur den Sound, der vom betreffenden Matrix angesteuert
wird. Ein weiterer Grund: Im Sequencer sind Pattern-Wechsel program-
miert, und wenn Sie während automatisierter Patternwechsel in den Pat-
terns editieren, kommen Sie schnell durcheinander.

In Kapitel 2 haben Sie bereits gesehen, wie Sie die Tonhöhe via Note-CV-
Out des Matrix anzusteuern. In unserem Beispiel ist stattdessen der
Curve-CV-Ausgang mit den Pitch-Inputs von Redrum verbunden. Vorteil:
Tonhöhenverläufe für realistische ›Trommelwirbel‹ lassen sich besser ein-
zeichnen. Da Matrix ein reiner ›Sequencer‹ ist, sind natürlich die Einstel-
lungen an Redrum entscheidend für das klangliche Endergebnis.

Mit etwas Feinjustage (Beispiel ›3drmsndsmatrixd.rns‹) wird der Beat ab-
gerundet: Die Noten-an/aus-Informationen des ›BD‹-Matrix für die Bassd-
rum haben relativ große ›Velocity‹-Unterschiede. In Redrum ist der ent-
sprechende ›Vel-to-Level‹-Regler aber nur moderat aufgedreht, sodass sich
diese nur subtil auswirken.

Der Verlauf für den ›SD‹-Wirbel wurde im Matrix eingezeichnet, anschlie-
ßend wurde der Empfindlichkeitsregler für die Pitch-CV-Eingänge auf der
Rückseite von Redrum passend justiert. (Steht dieser ganz links, ent-
spricht das einer Art ›Amount-0‹- oder ›Bypass‹-Einstellung).
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Die Empfindlichkeit für den Pitch-CV-In des Kanals 2 (Snare/ganz unten) wurde
reduziert, um so die durch die Kurveneinzeichnung in Matrix entstehenden
Tonhöhenverläufe subtiler wirken zu lassen.Die Empfindlichkeit für den Pitch-
CV-In des Kanals 2 (Snare/ganz unten) wurde reduziert, um so die Tonhöhen-
verläufe, die durch die Kurveneinzeichnungen in Matrix entstehen, subtiler wir-
ken zu lassen.

Die Noten-an/aus-Informationen des ›Bd‹-Matrix für die Bassdrum haben
relativ große ›Velocity‹-Unterschiede. In Redrum ist der Velocity-to-Level-
Knopf aber nur geringfügig aufgedreht, sodass sich auch diese ebenfalls
weniger gravierend auf die Lautstärke auswirken (Abbildung 3).

Abbveltolevel

Rechts neben dem Level-Drehknopf regelt der ›Velocity-to-Level‹-Knopf,
wie stark sich die Anschlagstärke bzw. der Wert des CV-In-Signals auf die
Lautstärke des Kanals auswirkt. ›12 Uhr‹ bedeutet dabei die Nullstellung. 
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Die Schnelligkeit der Snare-Wirbel entsteht durch die Patterns A2 und A3
im SD-Matrix. Diese sind in einer feineren Auflösung programmiert, was
automatisch schnelleres Abspielen bedeutet. Sinngemäß: Wenn ein Pat-
tern 32 Schritte hat und die Auflösung pro Schritt 1⁄16 beträgt, ist das Pat-
tern zwei Takte lang (32 × 1⁄16-Schritt). Ändern Sie die Auflösung auf 1⁄32, ist
das gleiche Pattern nur einen Takt lang (32 × 1⁄32-Schritt). Der Sequencer
muss die 32 Schritte nun doppelt so schnell abspielen.

Um besser experimentieren zu können, ohne Ergebnisse zu verlieren,
sollten Sie erstellte Patterns kopieren und dann weitere Veränderungen an
der Kopie vornehmen. Hierzu benutzen Sie das Edit-Menü, dessen Inhalt
sich an das jeweils angewählte Objekt anpasst. Klicken Sie jenen Matrix
an, an welchem Sie gerade arbeiten, und selektieren das von Ihnen er-
stellte Pattern (beispielsweise A1, siehe Abbildung). Wählen Sie anschlie-
ßend Edit > Copy Pattern. Selektieren Sie nun ein neues Pattern (etwa A2)
und wählen Sie anschließend Edit > Paste Pattern. 

Abbmatrixpatternselect
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Die Abbildung zeigt die Patternwahlschalter des Matrix. 48 Patterns pro
Matrix können gespeichert werden. Die lilafarbene Umrandung des Fel-
des zeigt an, dass Patternwechsel im Sequencer automatisiert wurden.

Snaredrum und Hi-Hat wirken im Beispiel besonders durch ihre Effekte.
Die Einzelausgänge von Redrum sind mit dem Mixer verkabelt. Der Aux
Send 1 (S1-Regler) von Redrum ist automatisiert und gibt auf diese Weise
nur jeder zweite Snare ein wenig Hall. Besagter S1-Regler aller Redrum-
Kanalzüge ist mit den Aux-Sends 1 des Mixers verlinkt, sodass das am Mi-
xer an den Aux Send 1 angeschlossene Hallgerät direkt aus Redrum ange-
sprochen werden kann. Alle Hallgeräte werden außerdem nicht über die
Aux-Returns, sondern über die freien Kanalzüge an den Mixer zurückge-
führt. Die Hi-Hat klingt durch das Delay (Aux Send 3) noch ein wenig hek-
tischer als zuvor. Das in den Mixer-Kanal 6 zurückgeführte Delay wird via
Aux Send 4 noch mit ein wenig zusätzlichem Hall versehen, im Kanalzug
wird außerdem etwas Bass aus dem Delay herausgenommen. Auch an
diesem Beispiel wird wieder deutlich, dass Reasons Vorteile gegenüber an-
deren Klangerzeugern insbesondere in der Flexibilität und Übersichtlich-
keit des Routings liegen.

Elektro-Drums mit Synthesizern bauen

Im Beispielsong ›subtractordrums1.rns‹ gibt es keine Samples, sondern
alle Drumsounds werden hier von Synthesizern erzeugt.

Viele Elektronikmusiker schwören auf solche ›Synth-Drums‹, da diese
sich ihrer Meinung nach viel besser modulieren und damit lebendig ma-
chen lassen als gesampelte Drums. Inwieweit das wirklich so ist, hängt na-
türlich von den verfügbaren Parametern im Sampler bzw. Synthesizer ab,
denn an einem guten Sampler kann man ebenfalls eine Menge ›drehen‹.
Aber ein kurzes, knackiges Bassdrum-Sample lässt sich nun einmal
schwer länger machen, und zudem erzeugen diese Synth-Drums eine
Elektroästhetik, die sehr typisch nach 80ern oder eben nach ›Elektro-Mu-
sik‹ klingt. In der Factory Soundbank finden sich viele Subtractor-Drum-
sounds. Wenn Sie sich die Synths genau anschauen, haben diese fast alle
eine Hüllkurve mit sehr kurzen Attack-, Decay-, Sustain- und Release-Wer-
ten eingestellt, um den Sound ›kurz‹ und perkussiv zu machen (siehe fol-
gende Abbildung).
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abb3002subtractbassdr

In ›subtractordrums1b.rns‹ werden die Decay-Werte der Amp Envelope
und der Filter-Envelope von Bassdrum 1 (BD1) moduliert. Ersteres macht
die Bassdrum länger, Letzteres macht sie heller.

In ›subtractordrums1c.rns‹ können Sie nachzuvollziehen, wie man eine
lange, tiefe Bassdrum bastelt, deren Ton nach dem Anschlag immer tiefer
nach unten sinkt. Im vorliegenden Beispiel ist für LFO 1 eine temposyn-
chronisierte Rate von ›4⁄4‹ eingestellt, er spielt also seine Wellenform nach
genau einem Takt wieder neu ab. Somit agiert der LFO hier eher wie eine
Hüllkurve. Ich habe das so gelöst, weil der LFO beide Oszillatoren anspre-
chen kann, während die Mod-Envelope nur einen der beiden Oszillatoren
alternativ moduliert. Diese Bassdrum setzt sich aber aus zwei Oszillatoren
zusammen, was man am aktivierten ›Osc2‹-Schalter und an der Stellung
des ›Mix‹-Reglers erkennen kann. Die gewählte Wellenform (Sägezahn)
ist zu Beginn ihres Zyklus ganz oben und sinkt dann kontinuierlich ab.
Das bedeutet, dass die Bassdrum zunächst höher klingt als das Original.
Als Gegenmaßnahme wurden beide Oszillatoren noch einmal um vier
Halbtöne heruntergestimmt.

In ›subtractordrums1d.rns‹ wird die Länge der Hi-Hat mit dem Decay-
Regler der Amp Envelope moduliert, sodass es etwa so klingt, als würde
abwechselnd eine geschlossene und eine offene Hi-Hat spielen.

In ›subtractordrums1e.rns‹ schließlich hören Sie den typischen ›Elektro-
Zap-Sound‹, und in ›subtractordrums1f.rns‹ kommt noch eine diskrete
Elektro-Loop vom Dr. Rex dazu.
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Techno- und House-Drums mit Redrum und Effekten

Bei House- oder Techno-Drums sind elektronische Schlagzeugsounds und
analoge Drum-Machines sehr verbreitet – die Sounds kommen aber sehr
oft auch aus Samplern wie der Akai MPC. House und Techno-Beats sind
meist ›leerer‹ als Drum-&-Bass-Beats und können somit leichter selbst
programmiert werden.

In ›technodrum01.rns‹ und ›technodrum01b.rns‹ spielt ein einfacher
Techno-Groove, der mit einigen Samples aus dem NN-XT und einem Bass
von Subtractor verstärkt wird.

Im NN-XT kommt wieder das ›48voice‹-Preset zum Einsatz, und Sie kön-
nen schnell neue Sounds nachladen. Durch die Leere der Beats fallen ge-
ringere Veränderungen stärker auf, auch die Rhythmik der Wiederholun-
gen muss stimmen.

Wie Sie sehen, ist der Einsatz von Rex-Playern auch bei Techno sinnvoll.
In den ›Electro‹- und ›Techno‹-Ordnern der Factory Soundbank befinden
sich jede Menge gute Drum-Loops, die zeigen, an welche Musik die Pro-
pellerheads gedacht haben.

Charakteristisch vor allem für House-Beats ist die Hi-Hat auf jedem zwei-
ten Achtel-Schlag (bzw. auf jedem ›Und‹-Schlag, wenn Sie einen Takt ›1
und 2 und 3 und 4 und‹ zählen).

In ›ravehousebeat01.rns‹ spielt nur ein Dr. Rex, der durch die Filterbewe-
gungen eines BV512 moduliert wird und dabei eine unglaublich gute Fi-
gur macht. Dieser EQ ist das beste Tool in Reason, wenn Sie die typische
dynamische DJ-Arbeitsweise bereits in Ihre Beats integrieren möchten.

Für etwas angezerrtere Techno-Beispiele öffnen Sie nacheinander
›mixerkett2.rns‹ (noch ohne House-Hi-Hat) und ›mixerkett3.rns‹. Drü-
cken Sie zum Abspielen bitte die ›Run‹-Taste von Redrum, es gibt kein Ar-
rangement.

In ›mixerkett2b.rns‹ sind die Kanäle 1 und 2 von Redrum 1 mit Redrum 2
via CV/Gate verbunden. So können Sie Ihre Redrum-Sounds ›layern‹: Re-
drum 2 spielt synchron und ergänzend zu Redrum 1.
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R ’n’ B- und Hip-Hop-Beats

Hier gilt wieder: Best of all worlds. Die für R ’n’ B- und Hip-Hop-Beats ein-
gesetzten Sounds klingen in der Regel organischer und weniger elektro-
nisch als bei Techno oder House. Das musikalische Feeling der alten
Loops wird von den Produzenten immer wieder gesucht, ähnlich wie bei
Drum & Bass. Kein Wunder, denn R ’n’ B ist ›Black Music‹ – genau wie die
meisten guten alten Groove-Loops. Und auch die Betonung der Snare-
Schläge 2 und 4 ist keine Seltenheit in diesem Genre. Aber auch hier wün-
schen sich nicht nur die Kids mit den dicken Bassboxen in der Hutablage
Druck, der normalerweise aus den alten Loops nicht kommt. Mir scheint,
dass dafür (zum ›Fettmachen‹ der alten Loops) weniger als im Drum &
Bass Equalizer zu Hilfe genommen, sondern stattdessen eher fette Elek-
tro-Samples oder Synthie-Drums unterlegt werden – wenn man hier über-
haupt von Gesetzmäßigkeiten sprechen kann.

Es ist auch logisch: Der Beat ist vergleichsweise langsam, und so hat eine
einzelne fette Bassdrum viel mehr Zeit, positiv aufzufallen. Ein zusätzli-
cher ergänzender Tiefbass ist zudem weniger vorgesehen als beispiels-
weise eine Funk-Gitarre, also darf die Bassdrum ruhig sehr tieffrequent
sein.

Ganz wichtig ist also die Bassdrum. Das haben seinerzeit Soul II Soul bei
›Back to Life‹ oder ›Keep On Moving‹ als erste erkannt, weitere Wegberei-
ter waren (die Produzenten von) Coolio, Luniz – und vor allem Dr. Dre
himself.

Öffnen Sie ›rnbhiphopbeats1.rns‹. Hier spielt Redrum immer dasselbe
Pattern, ergänzt von Beats aus dem Dr. Rex, die alle vier Takte wechseln.
Die ›handgespielten‹ Loops hauchen den fetteren Beats erst Leben ein.

Während Hip-Hop- und R ’n’ B-Beats häufig für Jungle-Tracks ›hochge-
pitcht‹ wurden, klingen bereits hochgepitchte oder sonstige Drum-&-Bass-
Loops als Rex-Files selten gut, wenn sie auf das langsame R ’n’ B/Hip-Hop-
Tempo zurückgeführt werden. Man muss aber auch gar nicht zu solchen
Maßnahmen greifen: Die Factory Soundbank bietet zwei Ordner voll mit
Hip-Hop- und R ’n’ B-Beats, die sich bei dem langsamen Tempo wunder-
bar entfalten – wie beispielsweise der Groove zwischen Takt 5 und 9.
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Auch für andere musikalische Komponenten (wie etwa Gesang oder Gi-
tarre) wird speziell in diesen Genres gern zu Loops gegriffen, die von
Schallplatten gesampelt wurden. Und das ohne jede Scham: Da wird gar
das Anschieben des Plattentellers mit aufgenommen oder simuliert, bevor
die ›Hitsequenz‹ spielt. Gleichwohl steckt in solchen Tracks oft viel Seele.
Wenn es gelingt, die einzelnen Komponenten gut zusammenzubringen,
kann etwas ganz Großes daraus werden. Zieht man alle Musiker zusam-
men, die an solchen Stücken beteiligt sind, inklusive derjenigen, welche
die Original-Loops fabriziert haben, kommt in der Regel deutlich mehr
musikalisches Können zusammen, als jeder Studioeinzelkämpfer haben
kann. Guter R ’n’ B ist denn auch oft mehr Teamwork als Musik von Ein-
zeltätern. Die beste Lösung bleibt natürlich: Arbeiten Sie selbst mit guten
Musikern zusammen.

In Reason gibt es vermutlich auch aus urheberrechtlichen Gründen nur
wenige Music-Loops. Einige Beispiele finden Sie unter ›rnbhiphop
beats2.rns‹. Das Beispiel ist 16 Takte lang, und alle vier Takte spielt hier
eine neue Loop. Wenn Sie sich vorstellen, dass bei Hip-Hop-Tracks solch
ein Thema mit kleinen Variationen über ca. vier Minuten durchgehalten
wird, haben Sie hier somit eigentlich Grundlagen für vier Hip-Hop-Tracks.

abb3003rnbhiphopbts30
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3   Musik machen mit Reason
Ob aus Ihren Beats eher softer R ’n’ B oder härterer Hip-Hop wird, hat mit
vielen Faktoren zu tun. Natürlich stehen beide Begriffe ohnehin nur für
Versuche einer Kategorisierung, für die man weitere typische Merkmale
finden kann, über die sich streiten lässt. R ’n’ B klingt schicker, und seine
Fans kleiden sich anders als Hip-Hopper, die vor allem ihre Straßenher-
kunft betonen möchten und mehr ›Sprach-Rap‹ als reinen Gesang ein-
bauen.

In den neuen Combinator-Patches findet sich ebenfalls ein schönes Bei-
spiel für einen Beat, bei dem eine Loop von Redrum Beats unterstützt
wird. Öffnen Sie ›90ssplithiphopr3.rns‹ und klicken Sie auf ›Play‹ oder
›Run Pattern Devices‹. 

Abb90ssplihiphopcombi
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Es gibt weitere, separate Buttons (›Run Redrum‹ und ›Run Loop‹), mit de-
nen Sie die Extra-Redrum-Schläge und die Loop getrennt voneinander hö-
ren können. Das hier geladene Performance-Patch aus der Reason-Sound-
bank bietet aber noch mehr Extras: Hier sind ein Piano, ein Bass- und ein
Streichersound bereits geladen, Sie müssen diese nur noch im Sequencer
ansteuern, in dem Sie eine entsprechende Spur dafür erzeugen.

Das habe ich in ›90ssplithiphopb.rns‹ für Sie erledigt. Dummerweise gibt
es im Originalpatch keine vernünftige Gerätebeschriftung, die habe ich
teilweise ergänzt, da man sonst im Sequencer beim Erzeugen der Spuren
schnell durcheinander kommt. Hierzu gibt es auch einen kleinen Lehr-
film ›Sequencertracksmanual.mov‹, wo Sie das nachvollziehen können.

Außerdem spielt noch eine Art ›Jazzfunkloop‹; mit dem rechten Dreh-
knopf ›Gtr Pattern 1-8‹ können Sie verschiedene Variationen davon ein-
stellen. Das funktioniert, weil ein Matrix-Sequencer mit verschiedenen
Patterns die Loop abspielt – ungefähr so, als hätten Sie ein MIDI-File dort-
hinein geladen und variiert. Leider lässt sich in einen Matrix keine MIDI-
Files laden.

Wenn Sie sich mit dem Thema Beats mit ein wenig Liebe und Einfüh-
lungsvermögen länger auseinander setzen, dann sehen Sie in Beats ir-
gendwann nicht mehr nur den Groove-Unterbau für ein Stück, sondern
Sie hören, dass gute Beats ›sprechen‹ können. 

Jeder einzelne Sound sagt etwas aus und transportiert auf seine Art genau
dasselbe Feeling und genau dieselbe Message wie der Rest der Musik.
Auch wenn Sie gelernter Pianist sind: Verweigern Sie den Beats nicht ihre
musikalische Bedeutung, sonst wird Ihre Musik selten das ausdrücken,
was Sie wollen – es sei denn, Sie verzichten ganz auf Schlagzeug, oder der
Rest Ihrer Musik ist unglaublich gut.

Apropos Piano: Auch das ist manchmal Bestandteil von Beats, wie das Bei-
spiel ›soulbeat1.rns‹ zeigt.

Etwas härter, bitte … 
Nachdem wir nun schon eine Reihe von Beats gehört haben, die als Unter-
lage für Hip-Hop-Tracks dienen können, geht es hier um die etwas rauere,
langsame Variante, die sich den Beastie Boys annähert. Und die klingt vor
allem: angezerrt.
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Öffnen Sie ›hiphop1.rns‹. Der Scream 4 erzeugt dabei vor allem durch
Übersteuerung des Eingangssignals eine angenehme Verzerrung, welche
die einzelnen Schläge auch ein wenig ›länger‹ macht, wie der Verlauf be-
weist. Zwischen Takt 5 und 9 ist der Scream kurz ausgeschaltet, und ob-
wohl synchron dazu der Groove vom Dr. Rex lauter wird, wirkt der Beat
völlig anders.

Der ›Damage-Control‹-Regler steuert, wie bereits erwähnt, nicht den zu
addierenden Effektanteil, sondern regelt lediglich den Pegel des Eingangs-
signals. In den Scream-4-Presets ist trotzdem meist eine Stellung des Da-
mage-Reglers mitgespeichert. Diese sorgt vermutlich in den meisten Fäl-
len für eine angemessene Relation von Eingangs- und Ausgangslaut-
stärke.

In ›hiphop2.rns‹ hören Sie jedoch, dass der Sound auch verzerrt klingt,
wenn der Damage-Regler unten steht und stattdessen die Lautstärke des
Dr. Rex hochgedreht wird. Auch dann wird, bei aktiviertem ›Damage‹-
Block, der Eingangsverstärker von Scream ›übersteuert‹. Das Ding ist also
irgendwie die entscheidende, aber unsichtbare Komponente in Scream.

abb3004scream4block1

Der ›Damage‹-Block des Scream 4.
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Akustische Drums für Jazz, Rock und Soul

Das Feeling eines guten Schlagzeugers mit einem guten Drumset können
Sie mit elektronischen Produktionsmitteln schwer übertreffen. Versuchen
Sie es, und Sie werden scheitern – versprochen. Ganz sicher können Sie
jedoch am Sound etwas verbessern.

Was Rock- und Jazz-Drums angeht, ist Reason nicht besonders gut ausge-
stattet. Eine Menge guter solcher Sounds gibt es jedoch etwa bei Wizoo
(www.wizoo.de) und in Wizoos Online-Sample-Shop ›wizoosounds.com‹
(www.wizoosounds.com).Ein Beispiel ist die CD ›Rude Loops‹, von der ich
einige Drum-Loops aufgenommen und editiert habe.

Zunächst habe ich sie in ReCycle zerschnitten und dann als Rex-Files in
Dr. Rex geladen. Denken Sie daran, dass Sie die einzelnen Sounds auch
ohne vorgegebenes Timing spielen können. Problematisch ist nur, wenn
wegen des nächsten Schnipsels der Nachhall fehlt. Da können Sie sich auf
mehrere Arten helfen, etwa so:

Öffnen Sie ›akustikdrums1.rns‹. Hier habe ich das ReCycle-File bewusst
so geschnitten, dass manche Schläge länger ausklingen. In ReCycle
konnte ich sehen, dass der Beat ca. 131 bpm schnell ist. Anschließend habe
ich die Einzelsounds in den NN-XT geladen, wo man sie etwas besser edi-
tieren und mit Effekten versehen kann als im Dr. Rex.

Wenn Sie die Factory Soundbank durchhören, werden Sie feststellen, dass
viele Hi-Hats, Snares etc. ebenfalls aus solchen Drum-Loops entnommen
wurden, selbst wenn dadurch die Schläge weder sauber ausklingen noch
frei von Nebengeräuschen sind. Allerdings hat solch ein Drumkit aus Ein-
zelsounds einer Loop auch Vorteile: Es klingt einfach homogener als ein
Kit aus lauter isoliert gesampelten Einzelsounds.

Öffnen Sie jetzt ›rockdrums1.rns‹. Hier spielen die Drums den Original-
groove. Der Klang ist nur mit Equalizern und Kompressor bearbeitet, wo-
bei besonders der Kompressor die Drums ›kräftiger‹ macht.
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In ›rockdrums1b.rns‹ spielt ein zweiter Dr. Rex zusätzlich eine Variation.
Um nicht alle Effektgeräte noch einmal öffnen und einstellen zu müssen,
wurde ein ›Spider Audio‹ zur Signalverteilung installiert. Beide Dr.-Rex-Si-
gnale gehen jetzt in den Spider statt in den ersten EQ, werden dort ›zu-
sammengefasst‹, und landen dann erst im EQ und den folgenden Gerä-
ten. Das ist genial – da braucht man keine Patchbay mehr.

Bei Jazz-Drums ist das Zerschneiden einer Loop in ReCycle ziemlich
schwierig, da hier oft unglaublich ›kleine‹, leise Sounds spielen. Falsche
Schnitte klingen immer holprig, egal, ob der Groove danach schneller oder
langsamer abgespielt wird.

Öffnen Sie ›jazzdrms1.rps‹. Hier spielt eine Loop aus der Wizoo-CD ›Rude
Loops‹, die in ReCycle zerschnitten wurde – und dafür habe ich ewig ge-
braucht.

In der Reason-Soundbank finden sich swingende Drum-Loops am ehes-
ten im ›Dub‹-Ordner der ›Dr Rex Drum Loops‹. Wollen Sie aber wirklich
Jazz-Drums mit Reason spielen oder produzieren, empfehle ich Ihnen,
sich nach entsprechenden Sample-CDs umzusehen, so hat etwa Best Ser-
vice einige gute Angebote

Öffnen Sie ›jazzdrms2.rps‹. Hier spielen Loops aus der Reason-Sound-
bank schon ziemlich jazzy – unterstützt vom schönen Hall des RV7000
und einem Kompressor. Noch mehr Spaß macht allerdings für meine Be-
griffe ›jazztry3.rps‹ ab der Stelle, wo die Wizoo-Loop ins Spiel kommt.

Wenn diese Beispiele eines beweisen, dann immerhin dies: Reason muss
nicht nach ›Krach‹ oder ›Techno‹ klingen. 

Alleinunterhalter oder Techno-Live-Act?

In den Ordnern ›Combinator Patches/Drums & Percussion/Machines‹
und ›Combinator Patches/Performance Patches‹ für das neue Combina-
tor-Instrument finden sich jede Menge Sounds, die ohne viel Zutun be-
reits Drumpatterns oder Melodiesequenzen (oder beides) abspielen. 
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An dieser Stelle möchte ich zuerst nochmal das grandiose ›Rhumbatro-
nic‹-Patch vorstellen. Mit dem Ding können Sie theoretisch als Alleinun-
terhalter auftreten. Wie bei einer Heimorgel können Sie bequem verschie-
dene Drum Presets aufrufen.

Abb93brhumbacombir3

Öffnen Sie ›rhumbar3.rns‹. Hier spielt der Rumba-Combinator mit ›ein-
gebauten‹ Rhythmussequenzen. Wenn Sie ›Play‹ oder ›Run Pattern De-
vices‹ drücken, spielt er automatisch. Das gleiche gilt für ›delmarr3.rns‹. 

Teilweise sind in den Geräten sogar schon Rhythmuswechsel program-
miert (ein Matrix steuert die Patternumschaltung), wie im Beispiel
›dancepattr3.rns‹, sodass es wirklich kinderleicht ist, schnell zu einem
recht weit entwickelt klingenden Ergebnis zu kommen. Wenn Sie anders
klingen wollen als andere, müssen Sie natürlich etwas mehr Arbeit hin-
einstecken. 

Der Combinator eröffnet völlig neue Dimensionen innerhalb Reasons,
und Sie sollten sich unbedingt in Kapitel 2 den Abschnitt ›Combinator:
Reason als Modularsynthesizer‹ ab Seite 222 durchlesen – und auch in Ka-
pitel 4 den Abschnitt ›Reason im Live-Einsatz‹ ab Seite 339.
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